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Copyright Notice 
 
Software and this Manual Copyright © 1994-2005 by Leighton L. Paul 
Licensed under U.S. Patent 4,669,891 John M. Rosevear 
GTS® Local Time Access Licensed Under U.S. Patent 5,982,710 Rives McDow 
 
Trademarks 
Apple, Macintosh, PowerBook, and OS X are trademarks of Apple Computer, Inc. 
HourWorld™ is a trademark of Paul Software Engineering. 
GTS® is a trademark of Rives McDow 
 
The software described in this manual is furnished under the license agreement below. 
 
HourWorld™ License Agreement and Liability Disclaimer 
 
By using HourWorld™ or HourWorld™ Lite, you agree to the following: 
 
HourWorld™ is a software program that provides information via text and graphic displays.  All 
the information (such as sunrise time, time in other cities, distance to a city, world 
light/dark/twilight situation, moon phase, etc.) is also available from other sources. HourWorld™ 
is provided as a convenience only, presenting the information perhaps more rapidly and 
attractively, and in perhaps more intuitive ways, than might be available from other sources.  
While care has been taken to ensure that HourWorld™ is reliable and presents accurate 
information, there are many possible occurrences within a computer, foreseen and unforeseen, 
that might cause the text or graphics displays to be incorrect. Therefore, you must agree to 
verify the accuracy and reliability of information presented by HourWorld™ prior to using 
it for any purpose. You specifically agree not to use the displays presented by HourWorld™ 
as your sole source of information when safety, health, or economic consequences are 
involved. 
 
In no event shall software author be liable to user for any special, indirect, incidental, or 
consequential damage, including, but not limited to, loss of revenue and loss of profits, or 
loss of life or property, even if author has been advised of the possibility of such damages. 
The maximum liability accepted will be the refund of the purchase price of this software, if any 
has been paid. Your registration and/or use of HourWorld™ or HourWorld™ Lite signifies your 
agreement with these conditions. If you do not agree to these conditions or if these limitations to 
liability are illegal in your jurisdiction, you must not use the software. 
 
HourWorld™ communicates with third-party software GPSy™ to obtain Global Positioning 
System (GPS) information for presentation. HourWorld™ is a not a professional navigational aid 
and should not be used as a primary means of navigation or in any situations where damage to 
life or property is possible. Unlike professional navigation aids, HourWorld™ may not provide 
any warning when the information being presented is stale, unreliable, or incorrect. 
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Limitations of License 
 
The following uses are OUTSIDE the scope of your license, and are NOT PERMITTED. If 
you acquired your copy of HourWorld™ for one of the following purposes, and do not wish to 
license it if restricted from these uses, please return the software or registration key for a refund. 
 
1) You may NOT use HourWorld™ as the only source or primary source of information 
when making decisions that may affect health, safety, or economic well-being. 
 
2) You may NOT use HourWorld™ as the sole or primary source of navigational 
information in any situation. 
 
3) You may NOT use HourWorld™ while driving a motor vehicle, riding a bicycle, piloting 
an aircraft, operating a water-going vessel, or operating any other conveyance.  Such 
operation is unsafe.  HourWorld™ 's display and text sizes are too small and too dim to 
convey information in these situations without dangerous distraction from your primary 
duties of operating the vehicle. 
 
When registering your copy of HourWorld™ a screen will give you the opportunity to accept or 
decline the terms of this agreement. If for any reason you do not accept these terms, please return 
the software for a full refund. 
 
Reasons behind the license limitations and disclaimer: 
 
1) When you are making decisions that affect health, safety, or economic well-being, it is 
common sense to double-check or triple-check your information. We do not wish to accept 
liability for careless use of our products. 
 
2) HourWorld™ is NOT a professional navigation aid.  Professional navigational aids are 
typically complete solutions from input to output, where the manufacturer has considerable 
control over how information is acquired, processed, and presented. Aircraft navigation 
instruments, for example, may acquire radio signals, process them, and present them on displays 
that are easily seen in a variety of lighting conditions. They are mounted in the aircraft in 
locations that are easily seen in a variety of lighting conditions with a minimum of distraction 
from other duties. A professional navigational aid will typically recognize poor signal conditions, 
and report that unreliability to the user. HourWorld™ is only a software link in a chain with 
many links that we do not control here at Paul Software Engineering. We cannot control the 
brightness or visibility of your display, nor its placement in your vehicle. HourWorld™ may not 
recognize unreliable signals, or software errors caused by us or by others may cause information 
to be unreliable. We especially believe that use of HourWorld™ as a navigational aid while 
operating any vehicle is unsafe!  
 
DO NOT USE HourWorld™ FOR PURPOSES OUTSIDE THE SCOPE OF THE 
LICENSE! 
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Installing HourWorld™ v. 3.2 
 
Before installing or running HourWorld™, be sure you have the right hardware and 
software. 
 
The HourWorld™ World Clock (or HourWorld™ Lite) version 3.2 requires: 
 
• A Power Macintosh or compatible. HourWorld™ WILL NOT run on an earlier Macintosh 
based on the 68000 family of microprocessors. If you need similar software for a 680x0 Mac, 
contact us for a copy of our WorldClock desk accessory. 
 
• Macintosh Operating System 9.1 or 10.x or later. 
 
• Approximately 10MB of free RAM memory. 
 
• Approximately 5 MB of free hard disk space for the program and documentation files. 
 
HourWorld™ as downloaded or provided on disk, and its accompanying files are 
contained in a folder. 
 
• Use the mouse to place the folder wherever you wish. 
 
• HourWorld™ and all associated files are contained within the folder, with the exception of a 
file named HourWorld™ 3 Prefs, which is created in your Preferences folder. 
 
HourWorld™ is an application program. 
 
• You may run HourWorld™ by double clicking on it. 
 
• Under OS X, you may also run HourWorld™ by clicking on its dock icon, if you have installed 
it in the dock.  To install HourWorld™ in the dock, drag the HourWorld™ icon to the dock from 
wherever you have installed it. 
 
After installation, please go to the next chapter - "Initial Setup" 
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Initial Setup 
HourWorld™ version 3 uses a new database design, and does not import settings from 2.xx 
versions of HourWorld™ that may be on your computer. It also requires a new registration key. 
 
This page and the next describe how to complete the initial setup of HourWorld™. The initial 
setup involves changing HourWorld's home location to a city near you in the same time zone as 
you are, and setting the correct time. To complete the final setup to your exact latitude and 
longitude, refer to the chapter titled "Changing Settings". 
 
Open HourWorld™ either by double-clicking on its icon or selecting it from the Apple menu, if 
you installed it there. The first thing that you will see is a dialog asking you for your time zone. 
Click and hold on the pop-up menu in the dialog and select the time zone where you are located. 
If daylight saving time is in effect, click the checkbox. When the time zone and daylight saving 
settings for your location are correct, click OK. 
 

 
 
Click on a clock that you wish to change to be your home location. 
 

  
When you click on a clock, a scrolling list will appear from which you may choose your home 
location. Choose your home location from the list, and check the “Home Location” box, then 
click the “Select” button. 
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After you press “Select”, the display should adjust itself, indicating the new location in the title 
bar at the top of the HourWorld™ window. 
 
If the location you selected is in a different time zone than the one initially chosen, the program 
will have adjusted the hours automatically for the difference in time zones.  
 
If HourWorld™’s time in the lower right corner of the map does not match system time, 
synchronize HourWorld™ to match system time by quitting HourWorld™ (Save the changes!!) 
and then running HourWorld™ again. The times should match when HourWorld™ restarts, and 
every time you start HourWorld™ thereafter. 
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What’s New in HourWorld™ 
Version 3 
 

HourWorld™ 3.2 is Carbon-based. It operates in native mode on both OS X and OS 9. The 
following features have been added since version 2.xx. 
 
GTS® is included - exciting new technology that calculates the current local time at any 
worldwide location. The GTS® library included within HourWorld™ provides accurate, reliable 
time for virtually every place on earth. GTS® brings to HourWorld™ a reliable, dependable 
source of worldwide time information. Whereas the earlier HourWorld™ database holds time 
zone and daylight saving data for approximately 1200 worldwide location, GTS™ extends the 
availability of that information to every point on earth. 
 
Time zone animation – zone outlines appear on the main maps, and moving the mouse across the 
map causes the time zone under the cursor to highlight. A panel appears at the lower left of the 
map that gives the current time in the zone that is highlighted. The time zones change in 
geometry throughout the year as different regions go on and off of daylight saving time. 
 
A political map is provided as an alternative to the satellite image. You may also choose an 
external map file of your choice. 
 
A new size option for 1280x1024 monitors is included. 
 
Earthlights, generated by use of electric lighting around the world, appear in the dark areas of the 
map. 
 
HourWorld™’s database has been expanded to hold up to 1200 locations. 
 
A View menu has been added, including several new view options. 
 

Upgrading to HourWorld™ 3.2 
from an Earlier Version 
 
HourWorld™ version 3.2 requires a different registration key than versions 2.xx. An upgrade 
key may be obtained online from http://order.kagi.com/?6R3&S 
 
HourWorld™ version 3.2 uses a new database structure that holds information not stored in 2.xx 
versions. As a result, HourWorld™ 3.2 will not obtain initial settings from a 2.xx version that 
may be on your hard drive. It will be necessary for you to reset your settings from previous 
versions manually. 
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HourWorld™ Display 
 
Use the HourWorld™ Display menu to choose from nine different functional screens. 

      
 
Analog Clocks - The Default Screen 
 
Depending upon the size of your display, the Clocks screen displays 5 to 15 clocks worldwide, 
set to the locations you choose from the database. Each clock shows the current time, date, and 
lighting at that location, the hours different from home, and the distance direction from home. 
Click on any clock to choose its location from the database. The clock will instantly show the 
time at that location. 
 
The included Global Time Systems (GTS®) library is used to generate and display worldwide 
time zones. The zone under the mouse pointer is highlighted in magenta, and the time under the 
mouse is displayed. 
 
Digital Clocks - Alternate Display Format 
 
Providing the same features as the analog clock display, the Digital Clocks screen offers an 
alternative for those who prefer digital instead of analog. 
 
Phone Call Coordinator 
 
Planning a phone call or conference call across time zones? The Phone Call Coordinator makes it 
easy to plan your call for the best time for you and the people you are calling. Also useful for 
radio operators and others who need to plan events across time zones. 
 
Sunrise, Sunset, & Twilight Today or Tomorrow 
 
These screens display the time and azimuth along the horizon for sunrise and sunset. Also 



 10

displayed are the times of beginning and ending of civil, nautical, and astronomical twilight, and 
hours of daylight. 
 
Sun and Moon Calendars 
 
Use these screens to find information about the sun's declination and the time and position of the 
sun at local noon. The moon calendar gives moon phase and the times and location of moonrise 
and moonset, and indicates the days during the month of the various moon phases. The calendars 
are active input devices, permitting you to quickly find data for any date. 
 
Sundial 
 
See at a glance the current solar situation and shadows. Animate to see the situation over a 24-
hour period. Click on the map to see the situation anywhere. 
 
GPS 
 
GPS stands for "Global Positioning System", a system of satellites orbiting the earth, 
transmitting signals to GPS receivers on land, sea, and in the air. HourWorld™ works with GPS 
receivers through GPSy™ software from Global Mapping Systems. To use GPS with 
HourWorld™, you need to have a GPS receiver, a cable that goes from the GPS unit to you 
Macintosh, and the GPSy™ software. 
 
The GPSy™ software communicates with the GPS receiver and passes the information along to 
HourWorld™ via interapplication communication. More information on GPS, GPSy™, and 
compatible GPS receivers may be obtained by contacting Global Mapping Systems at 
http://www.gpsy.com. 
 
In order to activate the GPS features in HourWorld™ a compatible GPS receiver must be first 
attached via a serial port (remember to do this with your Macintosh shut down), then the GPSy™ 
software must be started and a valid locational fix obtained. Once this is done, go the the Change 
Home Location Settings menu, click the Home Location button, and choose "GPS Location, 
Worldwide" as your current home location. 
 
Location Settings... 
 
The Location Settings screen allows you to set the time, location, time zone, and daylight savings 
rule to be used as HourWorld™ performs its calculations. This is where you select your own 
location, or the database location nearest you. 
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  Analog Clocks Screen 

 
 

The Analog Clocks screen is the first selection in the HourWorld™ Display menu in the 
menubar.  In addition to the map with the day/night pattern and the locations of the sun and 
moon, seven clocks are displayed (five clocks if you have chosen the small display option in the 
preferences screen). 
 
The Analog Clocks display is the default. Unless you have made a different default choice in the 
preferences, this is the display that you will see when you first run HourWorld™. You see the 
current day/night situation about the world, and the current time at a number of locations is 
shown on the analog clocks at the bottom. Moving the mouse across the map highlights the time 
zone under the cursor in magenta. The current time in that zone is displayed in a magenta 
rectangle at the lower left side of the map. If there is no mouse movement for 30 seconds, the 
time zone highlighting and time display disappears until the mouse is moved again. The location 
of a clock may be changed by clicking once on a clock, and then choosing a new location from 
the list that appears. 
 
The small 's' or 'd' in the upper right corner of each clock indicates whether standard or 
daylight saving time is in effect at that clock's location. Each clock shows the great-circle 
distance and initial great-circle direction from the computer's location (displayed at the top of the 
window) to the clock's location. Each clock also shows the number of hours it is ahead or behind 
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the computer's home location. 
 
If you wish, the preferences screen allows the distances to be displayed in kilometers. 
The location of each clock is displayed by a small rectangle on the map. The location of the 
computer is shown on the map with a small circle and cross (red on a color display). 
 
The Hour Scale: At the top of the map is an hour scale that shows approximate time around the 
world. Because political time zones don't follow an ideal pattern, and because daylight savings 
time or summer time may be in effect at some locations, the hour scale is only approximate. The 
hour scale shows the current whole hour that would be in effect in the idealized time zone (7.5° 
right and left of the meridian shown). For example, if it is 2:53 PM in the idealized time zone 
around a meridian, the indication would read "2p". 
 
The brightness of each clock face indicates the daylight, twilight, or nighttime condition at the 
respective location. Nighttime is shown with a black clock face, twilight with varying shades of 
gray. Sunrise and sunset is shown with red and orange hues on a color screen. 
 
Changing the Location of a Clock 
 
The clocks were set prior to distribution to 15 worldwide locations including Honolulu, Los 
Angeles, Denver, Chicago, New York, London, and Sydney. If HourWorld™'s size preference is 
set to "Small", only the first five clocks are shown. “VGA” displays seven clocks, “SVGA” 
displays nine, “XGA” displays 11, and SXGA displays 15 clocks. By clicking on any displayed 
clock, you may set that clock to any location in the included database. 

 
Clicking on a clock brings up a scrolling list of worldwide locations. The number of locations 
will vary, depending whether you are using HourWorld™ or HourWorld™ Lite, or whether you 
have added locations of your own to the database. 
 
Click on the location of your choice, and then click the "Select" button (or double-click on the 
location). The clock will display the time at the chosen location, including correction for daylight 
saving time if it is in effect at that location. 
 
When selecting a new location for the clock, if you wish to make the clock the "home" location, 
you may do so by clicking in the "Home Location" check box at the top of the list. 
 
You may override HourWorld™ 's default settings for daylight savings by un-checking the "Use 
Default" box and then clicking on the "Standard Time" or "Daylight Time" button as appropriate. 
The clock for this location will use the time rule (daylight or standard) you have chosen until you 
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change it. 
 
If you are unable to find the desired location or city in the scrolling list, you may add it to the 
database. See the instructions for adding locations to the database in the section on "Changing 
Settings". 
 
The Digital Clock Panel (lower right corner of the map) 
 

 
Click once on the digital clock panel to change to Universal (Greenwich) time. Click again to 
return to local time display. The format you have chosen will be remembered, and will 
automatically appear the next time you start HourWorld™. 
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 Digital Clocks Screen 
 

The Digital Clocks screen is the 2nd selection in the HourWorld™ Display menu in the 
menubar at the top of the screen. In addition to the map with the day/night pattern and the 
locations of the sun and moon, seven clocks are displayed (five clocks if you have chosen the 
small display option in the preferences screen). 
 

 
The operation of this screen follows all the same rules as the Analog Clocks screen, explained in 
the previous section. 
 
Click on a clock to change its location. 
 
Click on the panel in the lower right corner of the map to convert to show differences from 
Universal Time. Click again to show differences from local time. 
 
The 's' or 'd' indicates whether standard or daylight time is in effect at the location. 
 
The distance and initial true bearing are given from the home location to the clock location. 
 
The shading of the clock indicates daylight, relative twilight, or darkness at the clock location. 
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  Day/Night Time Strips 
 

The Day/Night Time Strips display shows the pattern of day and night at each of the clock 
locations used for the analog and digital clocks displays. The patterns are offset relative to the 
home location. 
 
The display is for the current date. You may use the date menu to experiment to see lighting 
conditions for different dates. 
 
The white regions represent daylight, the dark regions represent full darkness. The gray regions 
show civil twilight, then nautical twilight, then astronomical twilight. Locations near the poles 
will show the lighting conditions experienced there for the currently-selected date. 
 
The red reticle indicates current time. Use it to see the current time at each of the various 
locations. The blue reticle The is for your reference. You may set its location by clicking once 
where you want it. 
 
The time strips feature makes it easy to see time differences in both directions -- For example, it 
is easy to see that when it is 1 pm in Los Angeles, it will be 6 am in Sydney. In reverse, it is easy 
to see that when it is 9 am in Sydney, it will be 4 pm in Los Angeles. 
 

 
 
You may click on a location name to change a strip to another location. The change will also 
reset the clocks on the analog and digital clocks screens. 
 
Times in green or magenta (such as Honolulu in the example above) are previous day, compared 
to the current day at the home location. 
 
Times in cyan or red (such as Sydney in the example) are the next day, relative to the current day 
at the home location. 
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  Phone Call Coordinator 
The Phone Call Coordinator makes it easy to plan phone calls or other events that span multiple 
time zones. Each place that you call frequently may be set up with up to four good calling time 
intervals (calling time "windows") that appear in light blue. In planning a call,just look up at the 
top line (local location) to find suitable local times to make the call. 
 
The Phone Call Coordinator screen is the third selection in the HourWorld™ Display  menu in 
the menubar at the top of the screen. There are two options for the Phone Call Coordinator 
display, selectable from the Edit Preferences item on the Edit menu. The default option displays 
"windows" of good calling times at each location. The other option displays the pattern of day, 
twilight, and night at each location. 
 
Finding good times to call from the home location (the default option):  

 
 
The default calling windows built into HourWorld™ assume that the recipient of your calls is 
available from 8am until Noon, takes lunch from Noon until 1pm, and is available again for calls 
from 1pm until 5pm. You may change the default settings to reflect the actual best calling times. 
The red vertical line indicates the current time, and moves to the right as time passes. The blue 
vertical line is user-settable to make planning easier. To move the blue line to a new location, 
just click once where you would like it to appear. 
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To create or edit up to four calling time "windows" for each location, 
 
1) Choose "Change Location Settings" from the Edit menu. 
2) Click the Edit... Button 
3) Select the location to edit. 
 
A dialog will appear, including controls for setting up to four calling time "windows". 
 

  
 
4) Use the scrolling menus to define the start and stop times of each calling window. To 
eliminate a calling time window, set its start and stop times to 00:00. 
 
Multiple Contacts in the Same City: 
 
If you have multiple contacts in the same city with different calling windows because they have 
different working hours, or are available for contact at home in the evening, you may wish to add 
a separate location to the database for each contact. Instead of naming the location by city, you 
could name it for the contact, such as "Robert" or "Tom". To add a new location to the database, 
select "Change Location Settings" from the Edit menu, and click the "Add..." button. 
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  Sunrise, Sunset & Twilight 

  
 
The text beneath the map indicates the time and azimuth along the horizon for sunrise and sunset 
at the computer's location. Azimuth is measured clockwise from true north. In addition, times are 
given for civil, nautical, and astronomical twilight. 
 
• Civil twilight is bright twilight, where the sun is within 6° of the horizon. Generally, daylight 
activities can be carried out during civil twilight, without artificial lighting. 
 
• Nautical twilight is deep twilight where the sun is between 6° and 12° below the horizon. 
 
 • During Astronomical twilight (sun between 12° and 18° below the horizon) there is still 
enough light in the upper atmosphere to interfere with astronomical observations. 
 
A "Sun-Bar" near the bottom of the screen graphs the hours of day, twilight, and dark. 
 
The map is an active input area on the Sunrise screen. Click on the map to see sunrise, sunset, 
and twilight times at any worldwide location, including near the poles. When you are done 
experimenting, to reset to the original setting, click the Revert button. The "Sun-Bar" is useful in 
this mode, giving graphical information about the length of sunrise, twilight, and nighttime 
around the earth. 
 
Note: When using the map for input, idealized time zones are assumed. The actual, statutory time 
zones are not considered in the sunrise/sunset calculations when clicking on the map as an input 
device. To see the time at a specific location adjusted for daylight saving time, refer to its clock 
on the clocks screen. 
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  Sun Calendar 
 

Choose Sun Calendar from the HourWorld™ Display menu at the top of the screen. 
 
A calendar will be displayed beneath the world map. 
 

 
 
On the Sun Calendar display (above), to the right of the calendar you will see: 
 
• The day of the year. 
 
• The declination of the sun in degrees north or south of the Equator. The sun stays in a band 
between the Tropic of Cancer (23.5° north of the Equator) and the Tropic of Capricorn (23.5° 
south of the Equator). 
 
• The maximum altitude reached by the sun this day, and the time that occurs. This is the time of 
apparent (solar) noon at the computer's location. 
 
If you change the date using the calendar, HourWorld™ will ask you if you want to change the 
date at the time you close the program or click the go-away box. If you select "Save",your 
system clock will be changed to the new date. If you have only been experimenting, or checking 
on solar conditions for another date, and do not wish your system clock to be reset, do not select 
"Save" upon closing HourWorld™. 
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  Moon Calendar 
 

Choose Moon Calendar from the HourWorld™ Display menu at the top of the screen. 
 
A calendar will be displayed beneath the world map. 
 

  
 
On the Moon Calendar display (above), the calendar will indicate the days for new moon, first 
quarter, full moon, and third quarter, at the computer's location, considering daylight savings 
time if it is in effect. In addition, to the right of the calendar you will see: 
 
• The day of the year. 
 
• The time and direction (clockwise from true north) of moonrise and moonset. 
 
• The current phase of the moon, and the current altitude and azimuth of the moon from  your 
location. 
 
On both calendar screens, the calendar is an active input device. Click on a day of the month to 
recalculate the display for the date clicked upon. Click on a month to select the new month. Click 
on the year before or the year ahead to go back or forward a year. HourWorld™ will keep the 
new date you selected as you go to other screens. 
 
If you change the date using either sun or moon calendar, HourWorld™ will ask you if you want 
to change the date at the time you close the program or click the go-away box. If you select 
"Save", your system clock will be changed to the new date. If you have only been experimenting, 
or checking on solar conditions for another date, and do not wish your system clock to be reset, 
do not select "Save" upon closing HourWorld™. 
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  The Sundial 
 
The Sundial screen shows a rectangle with a simulated fencepost at the center. If the sun is 
above the horizon, the shadow of the fencepost is graphically displayed. If you let the program 
run all day, the shadow will move in the same pattern as a real shadow. 
 
When the sun goes down, the shadow disappears, and the surrounding rectangle becomes darker 
until it becomes black when the sun is more than 18° below the horizon. 
 
The Animate button on this screen will allow you to speed up the movement of the display to 
have 24 hours go by in a couple of minutes. 
 

 
 
After clicking the Animate button, it will change to a Real Time button. Click on the Real Time 
button to stop the animation and return to the correct display for the current date and time. While 
the display is animating, you may temporarily "freeze" the movement by clicking on the digital 
clock panel at the lower right of the map. To resume animation, click on the clock panel a second 
second time. 
 

 
 
To the right of the sundial rectangle, the text gives the azumuth (degrees clockwise from true 
north) and the altitude (degrees above the horizon) of both the sun and the moon. By selecting a 
future date on a "Calendar" screen, and animating the sundial to the desired time and then 
freezing the display, photographers can forecast the positions of the sun and moon for a "shoot", 
or can determine the best times or locations for a "shoot". 
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  GPS 
 

To use the GPS display, it is necessary to be running GPSy™ software from Global Mapping 
Systems, with a GPS receiver attached to your Macintosh. 
 
Please read the following important warning: 
 
------------------------------------------------------------------------------------------------------------ 
 
WARNING: 
 
HourWorld™ is NOT to be used as a primary navigational tool. Use of HourWorld™ as a 
primary navigational tool is OUTSIDE the scope of the license agreement. As a reminder, the 
following excerpt from the license agreement is repeated here: 
 
The following uses are OUTSIDE the scope of your license, and are NOT PERMITTED. If 
you acquired your copy of HourWorld™ for one of the following purposes, and do not wish to 
license it if restricted from these uses, please return the software or registration key for a refund. 
 
1) You may NOT use HourWorld™ as the only source or primary source of information 
when making decisions that may affect health, safety, or economic well-being. 
 
2) You may NOT use HourWorld™ as the sole or primary source of navigational 
information in any situation. 
 
3) You may NOT use HourWorld™ while driving a motor vehicle, riding a bicycle, piloting 
an aircraft, or operating a water-going vessel. Such operation is unsafe. HourWorld's 
display and text sizes are too small and too dim to convey information in these situations 
without dangerous distraction from your primary duties of operating the vehicle. 
 
------------------------------------------------------------------------------------------------------------- 
 
Unless you have a GPS receiver hooked to your computer, and are running GPSy™ software, the 
GPS functions will be unavailable. In order to use GPS information with HourWorld™, 
 
1) A GPS receiver must be attached to your Mac's serial port. 
 
2) Run GPSy™ (available from Global Mapping Systems -- www.gpsy.com) until a valid 
locational fix is acquired. HourWorld™ relies on GPSy™ to operate the GPS receiver, and 
receives its GPS information indirectly through GPSy™, not directly from the GPS receiver. 
 
3) Select "GPS Location, Worldwide" as HourWorld's current home location. 
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The GPS Display 
 

  
 
The GPS display shows an arrow with its tail at the current location. The direction of the arrow 
shows the current direction of movement. The length of the arrow increases with increasing 
speed. In order to keep the arrow from becoming too long to display, the length of the arrow is 
proportional to the square root of the speed. 
 
The panel at the lower right corner of the map extends to show the current speed and direction, 
updated every 5 seconds. 
 
Each location appears with the following information: 
 
Location name and current time there. 
 
Distance and initial direction from the home location. 
 
Current effective speed to or from. 
 
Estimated time enroute. 
 
Estimated time and date of arrival, assuming current speed and direction continue. 
 
To select a different location to appear in the display, click once on the location's display. A 
scrolling list will appear to select from. The locations displayed are the same as in the analog 
clocks, digital clocks, and phone call coordinator displays. 
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HourWorld™ Menus – Edit 
 

Use the Edit Menu To Edit Preferences or to Add, Remove, or Edit Database Locations 
 

 
 
In OS X, the Preferences are accessed from the HourWorld™ menu. 
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  Preferences 

 
  

The HourWorld™ preferences screen allows you to adjust various display options. 
 
• Setting System Clock - Allow or Prevent - If you wish to reset your system clock with other 
software, and to prevent HourWorld™ from adjusting your system clock, click the "Prevent" 
button. "Prevent" is the default setting. “Allow” is available only with OS 9. 
 
• Show Distances In - Miles or Km - "Miles" (statute miles) is the default setting. Each of the 
analog clocks on the "Clocks" screen shows the distance from the "Home Location" to the 
location represented by that clock. Click "Km" to change the display to kilometers.  
 
• Time Format - AM/PM or 24-Hour - "AM/PM" is the default setting. HourWorld™ as 
shipped assumes that you are a U.S. user, with the System Date and Time formats set the way 
they were when your system software was installed - to U.S. format, with 12-hour time. If these 
are the settings you are using (you can verify by using the Date andTime Control Panel), you can 
set HourWorld™ to display in 24-hour format by clicking the 24-Hour preference. 
 
• Background Processing - On or Off - "On" is the default setting, enabling HourWorld™ to 
keep displaying the correct time and world situation even when you are using a different 
program. Some users have reported that they like to keep HourWorld™ running on a second 
monitor, while they use other software on the main monitor. HourWorld™ updates itself once at 
the beginning of each minute, and you may notice a slight processing interruption in the program 
you are using while this occurs. If this is bothersome, and you want to leave HourWorld™ open, 
then you may wish to turn background processing off. With background processing off, 
HourWorld™ will update itself only when it is the active (frontmost) process. 
 
• Default Display - Clocks, Sunrise Today, Sun Calendar, Moon Calendar, or Sundial - Use 
the pop-up menu to select which screen you want to first appear each time you open 
HourWorld™. 
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  Add Location to Database... 
 

  
 
Selecting “Add Location to Database…” from the Edit menu brings up the above dialog. To add 
a location, enter the information asked for, and press the “Done” button. 
 
 
 

 Remove Location from 
Database... 
 
Selecting this option from the Edit Menu brings up a dialog with a scrolling list of locations in 
the database. Click on the location to be removed from the database, and click the “Remove” 
button. The location will be removed permanently if you save the changes when quitting 
HourWorld™. 
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  Choose Home Location... 
 

You may set the home location for HourWorld from this option. Click on the city you wish to be 
the home location, and then click the Select button. 
 
If the location you choose is not in the time zone previously selected, HourWorld’s time will 
change. 
 
You may also set the home location by clicking on the clock you want to represent home, and 
checking the Home Location box before selecting the location. 
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The View Menu 

 
  
Use the View Menu to set appearance items that affect all of HourWorld’s display screens. The 
changes you make with the View Menu take place immediately, and will persist the next time 
you run HourWorld. 
 
The Size, Map, Distances, Zone Markings, Night Region Shading, and Lat/Lon Grid items each 
bring up a submenu. 
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Size Submenu 

 
 
HourWorld™ displays in five different sizes, each tailored to fit and work well on one of the 
popular monitor sizes. The options are “Small” for the old Mac Classic 400x300 screen, “VGA” 
for the 640x480 pixel display, “SVGA” for 800x600, “XGA” for 1024x768, and “SXGA” for 
1280x1024. The size selected determines the number of clocks that are displayed as follows: 
Small – 5 clocks; VGA – 7 clocks; SVGA – 9 clocks; XGA – 11 clocks; SXGA – 15 clocks. 
 
When you select a new clock size, there will be a delay of a few seconds while HourWorld 
generates the display information including the current time zone boundaries for the size 
selected. 



 30

Map Submenu 

 
 
Choose the underlying map for HourWorld™ to display from the View menu. Choose from the 
default Satellite Image, an internal Political Map, or a custom map. Choosing the custom map 
will bring up a scrollable dialog from which you may select a map. The map file you select 
should be in the following format: A “plate caree” image of the entire earth (where one degree of 
latitude and one degree of longitude are represented by a constant number of pixels throughout 
the entire image), in PICT file format. If you have a map file in a different format, such as GIF or 
JPEG, you may convert it to PICT with a utility such as GraphicConverter. 
 
The coloring of the Satellite Image and the Political Map have been tailored to work well with 
HourWorld™’s night/dark coloring scheme. If you are using a custom map file, you may wish to 
adjust its brightness, contrast, or color balance with a utility such as GraphicConverter in order to 
give it a good appearance. 
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Distances Submenu 

 
 
HourWorld™ displays distances on the clocks in statute miles by default. You may choose 
kilometers or nautical miles instead. These changes will affect the Analog Clocks screen, the 
Digital Clocks screen, and the GPS screen. 
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Zone Markings Submenu 

 
 
Zone markings appear under the map. These zones are approximate only. 
 

 
 
Degrees of Longitude: degrees East or West from the Prime Meridian (center of map) 
 
Hours from UT: the number of hours to add to or subtract from time at the Prime Meridian 
 
Hours from International Dateline: hours Eastward from International Dateline 
 
Letters A – Z: the traditional military time zones (Zulu time at Prime Meridian) 
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Night Region Shading Submenu 

 
 
Night Region Shading sets the darkness of the night region on the display. Default is the 
middle setting, “Darker”. Changes made to this setting will persist the next time you start 
HourWorld™. 
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Lat/Lon Grid Submenu 

 
 
Lat/Lon Grid lets you choose whether or not to display the grid of latitude and longitude 
markings on the map, and the color that it is used to display the grid. “Black” is the default 
setting. Changes you make here will persist the next time you start HourWorld™. 
 
 
 

 Circles, Tropics, Equator 
 

Choose to display the Arctic and Antarctic Circles, Tropics of Cancer and Capricorn, and 
the Equator. The default setting is to display them. A checkmark appears in the menu 
when this display option is on. 
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  Az/Dist/•T info on Clocks 
 

When this option is selected, the direction, distance, and time difference from the home location 
is displayed on each clock. When this option is off, the clocks have a less cluttered appearance, 
showing the time only. 

 
 
Distances will be shown in the units selected from the “Distances” submenu of the View menu – 
Statute Miles, Kilometers, or Nautical Miles. Changes made here will persist the next time 
HourWorld™ is started. Clicking on the small time panel at the lower right corner of the map 
will cause the clocks to display time difference from UT instead of the home location. 
 

 Twilight Blending 
 
The default setting is to show the natural blending of daylight into darkness around the world. 
You may choose to turn it off, instead showing an abrupt boundary between daylight and night. 
Turning it off reduces the number of computations HourWorld™ must make, making the 
program more responsive to changes. Animations using the “Sundial” screen will be much faster 
with Twilight Blending turned off. 
 

QuickTime™ and aTIFF (Uncompressed) decompressorare needed to see this picture.

  Time Zone Hints 

 
  
be set in the Preferences. If you use the Date or Year menus to select different dates than today, 
HourWorld™ may require several minutes to calculate time zone boundaries for the new date. 

When the Time Zone Hints 
option is active, the current 
boundaries of the time zones 
appear on the map. Each light 
hint line marks a boundary 
where the local time is 
different as you cross the line. 
When the option is not active, 
the time zone hints disappear. 
In order for time zone hints to 
appear, the GTS® option must
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 Staggered Clocks 

 
  
The default setting is to display the world clocks in a straight line across the bottom of the map. 
Your author likes them this way. If you prefer, you may display them alternating up and down as 
in the graphic above. 
 
 

 Clock Locations on Map 
QuickTime™ and a

TIFF (Uncompressed) decompressor
are needed to see this picture.  

  
The default setting is to show the location of each clock on the map. The letter designator of each 
clock also appears on the clock at the bottom of the screen. You may turn this option off. 
Changes you make here will persist the next time you start HourWorld™. 
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The Year Menu 
 

By default, the current date is used when HourWorld™ starts up. To display the same 
time, month and date, but a different year, you may select the year desired from the Year 
menu. Since the solar lighting situation for a particular date varies little from year to year, 
you will notice little change, except for the position of the moon, which does not follow 
the solar cycle. 
 
Since time zones do change according to politics and laws, HourWorld may not be able 
to display the time zones for a year too far into the future. 
 
Changes made on the Year menu will not be saved. The next time you start HourWorld, it 
will obtain the current year from the system clock. 
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The Date Menu 
 

By default, the current date is used when HourWorld™ starts up. To display a different date in 
this same year, you may select the date desired from the Date menu. 
 
Since time zones do change according to politics and laws, HourWorld may not be able to 
display the time zones for a Date too far into the future. 
 
Changes made on the Date menu will not be saved. The next time you start HourWorld, it will 
obtain the current date from the system clock. 
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The Time Menu 

 
 
By default, the current time is used when HourWorld™ starts up. To display a different tem for 
this same date, you may select the time desired from the Time menu. 
 
After experimenting with different times, you may return HourWorld™ to current system time 
by choosing the “System Clock Time” option. 
 
Changes made on the Time menu will not be saved. The next time you start HourWorld, it will 
obtain the current time from the system clock. 
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The File Menu 

 
 
 

The HourWorld & Apple Menus 
 
The Apple Menu under OS 9 and the HourWorld Menu under OS X contain similar 
items. 
 

 

 
From these menus, if you have an 
active Internet connection, you may 
visit hourworld.com, send an Email 
to the author, or order a registration 
key. Once a registration key has 
been purchased, you may enter it 
here. To quit running HourWorld, 
choose the Quit option form the 
HourWorld menu under OS X or 
from the File menu under OS 9. 

 
 
From the File menu, you may create a 
tab-delimited text almanac file for the 
home location for any month or year. The 
file that is created can be read by 
Microsoft Excel or other spreadsheet, 
reorganized there, and printed. From the 
File menu, you may also print an almanac 
directly, print the HourWorld window, or 
print an order form. 
 


